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INTRODUCTION TO THE TEACHER GUIDE

A perfect guide for an ICT teacher is one that provides support to the teacher to engage the students in 
joyful learning. Information and Communication Technologies (ICTs) refer to the possibilities offered by the 
convergence of data processing techniques, electronic media, and telecommunications, a convergence that has 
become evident over the past few years. 

 ICTs are grouped under two categories: traditional and new. Traditional ICTs are radio, television, and 
fixed line telephones etc., which have been gradually ingrained in the daily habits and lives of people and 
communities. New ICTs consist of computers and specific data processing applications accessible through those 
computers (e-mail, Internet, Word processing, and other data processing applications). 

 New ICTs are now found on the development agenda of African countries like Ethiopia, and strategies have 
been gradually implemented to integrate them into the development process. Many countries have initiated 
significant reforms in the telecommunications sector: privatizing companies, liberalizing and ending national 
monopolies in this sector. 

 This Teacher Guide will help the teachers to:

  explain how Information and Communication Technology (ICT) has the potential to make a real 
improvement to teaching and learning in schools.

  demonstrate a wide variety of ways in which ICT can be used to enhance learning, offering a fresh burst 
of inspiration for them i.e., the busy school teachers.

  take a structured approach, ensuring that the students can be guided progressively through all the contents 
in order to achieve the required standards for achieving Qualified Teacher Status, and also to continue 
their development in ICT to an advanced level. 

  analyze all the common ICT tools and explain how they can exploit these tools for effective learning.

  explore how students can learn with ICT, how their skills develop, and how these skills can aid their 
learning.

  provide a framework for planning, analyzing and evaluating teaching with ICT.

  use Internet, educational trips and other aids to support class room teaching.

  prepare additional activities and assessments for the students.

  offer a range of innovative tasks, resources and methods of assessment.

  use key ideas, skills and techniques of ICT in other curriculum areas.

 The guide also provides websites that have additional content for the teacher.
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INFORMATION 
SYSTEMS

(15 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l know the application of ICT in different sectors;

 l understand the components of an Information System;

 l recognise the application of ICT in different sectors;

 l recognise how ICT can change the life of people.

suGGested lesson plAn

Sub-units
Number of 

Periods

1.1 General Concepts of Information 
Systems

3

1.2 Types of Information System in 
the Organization

8

1.3 Impact of ICT in Everyday Life 4

struCture of the unit

1.1 General concepts of information Systems

In this sub-unit, we will learn about general concepts of 
Information Systems. The topic to be learnt is:
 l Some applications of ICT at Home, Office, 

Factory, Transport, Communications, Education/
Training and Health.

1.2 types of information System in the 
organization

In this sub-unit, we will learn about types of 
Information System in the organization. The topics to 
be learnt are:

 l Definition of system and characteristics

unit 1   

 l Application of Information System types
  Transactional Information System
  Management Information System
  Decision Support System
  Executive Information System
  Offi  ce Automation Information System

1.3 impact of ict in Everyday Life

In this sub-unit, we will learn about impact of ICT in 
everyday life. The topics to be learnt are:

 l Define a digital device
 l Impact of using computers in offices
 l Impact of mobile phones
 l Impact of satellite broadcasting
 l Differences between information poor and 

information rich society

review of the unit

	 l A system is a set of related parts that operate 
together to perform a specific function.

 l Information systems have not yet gotten to the 
point where they can think, plan, and react to 
changing circumstances. So, people work on 
information systems.



Unit 1 – Information Systems

	 2	  n	 Information Communication Technology — Grade 11 Teacher Guide

	 l	The vast majority of end-users use computers in 
their own fields of interest.

	 l	Some applications of ICT are at Home, Office, 
Factory, Transport, Communications, Education/
Training and Health.

	 l	 Information system is a system that provides 
information to people in an organization.

	 l	A system is an interrelated set of components 
with an identifiable boundary working together 
for some purpose.

	 l	The major characteristics of a system are:
		 Components, Interrelated components, A 

boundary, A purpose, An environment, Interface, 
Input, Output and Constraints.

	 l	The types of information systems are:
		 Transaction Processing System, Management 

Information System, Decision Support System, 
Executive Information System and Office 
Automation System.

	 l	 ICT enables rapid access to ideas and experiences 
from a wide range of people, communities and 
cultures, and allows pupils to collaborate and 
exchange information on a wide scale.

	 l	A digital device is a device that works with 
discrete numbers or digits.

	 l	Computer has brought many changes in 
employment, including changes to office 
equipment, office location, work schedules and 
the types of work people are seeking.

Additional Class Activities for Gifted Students or slow learners

  Activity 1.1: Information Systems in an Enterprise

Students in their class will explain and discuss Information Systems in an Enterprise with the help of flow 
diagrams (see Fig. 1.1).

Fig. 1.1: Systems for an enterprise

	 l	Mobile phones are the easiest and the simplest of 
the methods to stay connected with others, and 
moreover they provide a sense of security.

	 l	Satellite technology plays an important role in 
communication globally.

	 l	The Information Age/Digital Divide separate the 
information rich and the information poor.

Role of the students

In this unit, the students are supposed to learn 
Information Systems. The activity based method 
should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter. At present students have better ways 
of learning ICT.
	 l	The way in which students learn has changed, 

and that sitting in a passive mode in large lecture 
halls is not the expectation.

	 l	Due to advancement in technology, today’s 
students are different than those for whom 
the educational system was initially designed 
for because students “think and process 
information fundamentally differently from 
their predecessors” having grown up around 
computers, video games, and the Internet.

	 l	They represent a generation which is completely 
surrounded by ICT where e-mail, instant 
messaging, and cell phones are integral parts of 
their lives.
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Business Processes

	 l	Manner in which work is organized, coordinated, and focused to produce a valuable product or service.
	 l	Concrete work flows of material, information, and knowledge—sets of activities.
	 l	Unique ways to coordinate work, information, and knowledge.
	 l	Ways in which management chooses to coordinate work.

Fig. 1.2: Traditional View of the Systems

  Activity 1.2: Common ICT Applications

Students in their class will explain and discuss common ICT applications.
	 ‘ICT application’ is a technical term for a standard computer program. Common ICT applications are 
Wordprocessors, Desktop Publishing (DTP) software, Spreadsheets, Databases and Presentation software.
	 Students and teachers can make great use of standard ICT applications in their work. Students can develop 
their ICT skills by studying these applications.
	 These days many schools make use of Microsoft Office with a standard set of applications that can be used 
by all to develop their ICT skills:

  Activity 1.3: The Impact of ICT on Society

Students in their class will explain and discuss the impacts of ICT on society.
	 Some impacts of ICT on society are given below:

	 1.	Faster Communication Speed
	 l	 In the past, it took a long time for any news or messages to be sent. Now with the Internet, news or 

messages are sent via e-mail to friends, business partner or anyone efficiently.
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	 l	 With the capability of bandwidth, broadband and connection speed on the Internet, any information 
can travel fast at an instant. It saves time and is inexpensive.

	 2.	Lower Communication Cost
	 l	 Using the Internet is cost-effective than the other mode of communication such as telephone, mailing 

or courier service. It allows people to have access to large amounts of data at a very low cost.
	 l	 With the Internet we do not have to pay for any basic services provided by the Internet. Furthermore, 

the cost of connection to the Internet is relatively cheap.
	 3.	Paperless Environment
		  ICT technology has created the term paperless environment. This term means information can be stored 

and retrieved through the digital medium instead of paper. Online communication via e-mail, online chat 
and instant messages also helps in creating the paperless environment.

	 4.	Effective Sharing of Information
		 People can share and exchange opinions, news and information through discussion groups, mailing list 

and forums on the Internet. This enables knowledge sharing which will contribute to the development 
of a knowledge based society.

	 5.	Social Problems
	 l	 There are some negative effects of ICT.
	 l	 Now-a-days, people tend to choose online communication rather than having real time 

conversations.
	 l	 People tend to become more individualistic and introvert. Theft, hacking, pornography and online 

gambling are some evils spread by ICT. This will result in moral decadence and generate threat to the 
society.

	 6.	Health Problems
	 l	 A computer may harm the user if they use it for long hours frequently.
	 l	 Computer users are also exposed to bad posture, eyestrain, physical and mental stress.
	 l	 In order to solve the health problems, an ergonomic chair can reduce back strain and a screen filter 

can minimize eyestrain.

Answers to Textbook assessments

Assessment 1.1

Fill in the Blanks

	 1.	 Information	 2.	 applications
	 3.	Endoscopy	 4.	 offices

State Whether True or False

	 1.	False	 2.	 True
	 3.	False	 4.	 True
	 5.	True

Answer the Following

	 1.	 ICT has a large number of applications in 
different sectors of life. Some applications of ICT 
are described below:

		 Home
		 When your computer is connected to a CD-ROM 

drive, encyclopaedic information, movies and 
animations are instantly available. When your 
computer is connected to the phone line, you can 
visit your community or other parts of the world. 
The lines between work, play and education are 
beginning to disappear as ICT resources once 
available only at work or school become available 
at the home.

		 Using the World Wide Web at your home you can 
research school or work assignments, exchange 
e-mail, join special interest groups, download 
files, play games, or make airline reservations.
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	 	Sales catalogues are now being computerized 
and many catalogues are even put on the web 
so you can do online shopping. With an Internet 
connection, you can read the newspaper. You 
can get study material on CD-Rom discs or 
over the Internet. Home shopping and banking 
are growing areas of ICT. There are sites through 
which one can search for new friends while 
sitting at home. You can make your travel plans, 
check weather or chat with your friends over the 
Internet, without moving out of your home.

		 Office
		  ICTs are everywhere and offices are using them 

in newer ways, unthought of even a decade ago. 
You could list thousands of these modern uses.

		 Without computers, the modern offices would 
almost instantly grind to a halt. Computers have 
become so deeply embedded in information 
processing and communications systems that 
almost no activity would be possible without 
them. Failure of the telecom and electrical 
company’s computers would shut off those 
services.

		 The ICTs are integrated into offices in the 
following ways:

	 (i)	 Transaction processing
	 (ii)	 Home-based workers
	 (iii)	 Desktop publishing
	 (iv)	 Financial analysis
	 (v)	 Product design
	 (vi)	 Architectural walk-through
	 (vii)	 Factories etc.
		 Factory
		  ICTs have a major impact in industries where 

products are designed and manufactured. 
Computer-Aided Design (CAD) is used to 
design and develop products. Computer-Aided 
Manufacturing (CAM) is used to manufacture 
them.

		 Factory floors are becoming increasingly 
populated by computers used for many purposes 
including inventory control and planning and 
process control.

		 Computers are also used to run robots that 
create, finish, assemble and test products and 
their components.

	 	Transport
		  In the transport sector, ICT applications are used 

to improve road, air and rail transportation. 
ICT applications are noticeable in air traffic 
control, monitoring of freight and the day-to-day 
transport system. For example, we can book air 
tickets or railway tickets online. Pilots are trained 
on software, which simulates flying.

		 The air traffic control and rail signals are also 
among ICT applications.

		 Communications
		 This has been one of the most recognised uses of 

the ICTs. Various communication technologies, 
ranging from broadcasting to telecommunications 
and to the Internet are playing effective roles in 
the acquisition and sharing of information. Almost 
all mobile phones have software embedded in 
them.

		 The concepts of the ‘information revolution’ and 
‘information society’ are driven by enormous 
advancements in ICTs and their application. The 
Internet for example, has provided platforms for 
sharing information in applications such as the 
e-mail and the World Wide Web.

		 Satellites are commonly used in ICTs. They may 
simply relay signals from one point to another, 
eliminating the need for wires between two 
locations. They also broadcast TV and even 
Internet signals that can be picked up even by 
small dish antennas.

		 Education/Training
		 The education sector is arguably one major 

area in which ICTs are playing a remarkable 
role. Computers are serving as the best friend 
to both the teacher and the students. You can 
find a computer in a classroom, in a library or 
in a museum. The ability to connect computers 
and students together over a network such 
as the Internet opens up fantastic educational 
opportunities.

		  In schools computers are increasingly being 
used to teach ICT courses like the ones you are 
taking. For example, this text has ICT application 
integrated into it. An e-learning software 
supplements the knowledge you get by studying 
books.	

		 Elementary and secondary schools are using 
computers to play multimedia educational 
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programs and to teach kids to explore the web for 
information. We can give online examination and 
get instant results. We can check our examination 
results online.

		 Ministry of Education, Ethiopia is soon going to 
launch a series of educational programs that will 
be broadcast on TV channels. In Ethiopia, various 
universities are developing online certification 
courses for those people who do not have 
time or resources to take regular classes. Thus, 
various ICT tools help in providing education 
and becoming more knowledgeable as well as 
more qualified.

		 Museums use interactive multimedia to educate 
visitors on topics from science to fine art. 
Increasingly, these exhibits are being put on 
the web so you can visit them on your own. 
ICTs are especially valuable for students with 
special needs. A computer’s voice recognition 
capabilities and its connection to the Internet 
makes it possible for special education users to 
participate in learning experiences from which 
they may have previously been excluded. For 
example, the Short Message Service (SMS) can be 
used to send and receive messages by the hearing 
impaired, the voice activated dialing service can 
be used by visually impaired.

		 Training programs in business and various 
organizations are huge and expensive. To save 
money and improve performance, companies 
are using Computer-Based Training (CBT) to 
train people on procedures and techniques they 
need to know in their jobs. Training programs 
in organizations rely heavily on ICT sectors 
such as video conferencing. Virtual reality is 
now used to train pilots by putting them into a 
cockpit simulator where they can experience the 
sensations associated with various maneuvers as 
they learn to handle them.

		 Health
		  ICTs are widely used in the field of medicine. 

They support efficient exchange of information 
between health professionals, they enable 
transfer of patient records between sites and they 
can improve clinical effectiveness, continuity and 
quality of care by health professionals. Physicians 
use ICT to understand the human body and to 
diagnose disorders.

		 Several computer controlled machines are 
being used in modern hospitals. The computer 

controlled laser machines are used in surgery. 
The complex surgeries can be performed by 
smallest possible cuts on the patient’s body. This 
is done by operating through a technique, called 
Endoscopy. This involves the use of computers, 
small cameras and other devices for operating 
upon the patient.

		 The ICTs are also helpful in training doctors 
for surgery. The surgeries can be performed on 
computer controlled models or by using virtual 
reality techniques. These models simulate a real 
life environment by using computers to perform 
a particular task.

Suggested Activities
	 Refer to sub-unit 1.1 of the Student Textbook for 

doing the activities.

Assessment 1.2
Fill in the Blanks
	 1.	 Information System	
	 2.	 components
	 3.	Management Information System (MIS)
	 4.	Decision Support System (DSS)
	 5.	Executive Support System (ESS)

State Whether True or False
	 1.	False	 2.	 True	 3.	 True
	 4.	True	 5.	 False

Answer the Following
	 1.	The definition of system and its characteristics 

are given below:
		 A system is an interrelated set of components with 

an identifiable boundary working together for 
some purpose. A system has nine characteristics 
as shown in Fig. 1.3:

Fig. 1.3: A general illustration of a system
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	 	The system characteristics are discussed below:

	 (i)	 Components: A system is made up of 
components. A component is either an 
irreducible part or an aggregate of parts, also 
known as a subsystem. The simple concept of 
a component is very powerful. For example, 
just as with an automobile or a stereo system 
with proper design, we can repair or upgrade 
a system by changing individual components 
without having to make changes throughout 
the entire system.

	 (ii)	 Interrelated components: The components 
are interrelated, that is, the function of one 
component is somehow tied to the functions 
of the other components. For example, the 
work of one component, such as producing a 
daily report of customer orders received, may 
not progress successfully until the work of 
another component is finished, such as sorting 
customer orders by date of their receipt.

	 (iii)	 A boundary: A system has a boundary within 
which all of its components are contained 
and that establishes the limits of a system, 
separating the system from other systems. 
Components within the boundary of a system 
can be changed, whereas things outside the 
boundary cannot be changed.

	 (iv)	 A purpose: All of the components work 
together to achieve some overall purpose for 
the larger system: the system’s  main reason 
for existing.

	 (v)	 An environment: A system exists within an 
environment which comprises of everything 
outside the system’s boundary. For example, 
we might consider the environment of a 
state university to include the legislature, 
prospective students, foundations and 
funding agencies and the news media. Usually 
the system interacts with its environment, 
exchanging, in the case of an information 
system, data and information.

	 (vi)	 Interfaces: The points at which the system meets 
its environment are known as interfaces, and 
there are also interfaces between subsystems. 
An example of subsystem interface is the 

clutch subsystem, which acts as the point 
of interaction between the engine and 
transmission subsystems of a car. 

	 (vii)	 Input: A system takes input from its 
environment in order to function. Mammals, 
for example, take in food, oxygen and water 
from the environment as input. A system 
cannot function properly if inputs are 
inaccurate or faulty.

	 (viii)	 Output: Finally, a system returns output to its 
environment as a result to its functioning and 
thus achieves its purpose.

	 (ix)	 Constraints: A system must face constraints 
in its functioning because there are limits 
(in terms of capacity, speed, or capabilities) 
to what it can do and how it can achieve its 
purpose within its environment. Some of these 
constraints are imposed inside the system (e.g., 
a limited number of staff available), whereas 
others are imposed by the environment 
(e.g., due dates or regulations imposed by 
government or some other agency).

	 2.	The definition of each type of Information System 
is given below:

	 l	 Transaction Processing System: A Transaction 
Processing System (TPS) is a computer-based 
information system that keeps track of the 
transactions needed to conduct business.

	 l	 Management Information System: A Management 
Information System (MIS) is a computer-based 
information system that uses data recorded 
by TPS as input into programs that produce 
routine reports as output.

	 l	 Decision Support System: A Decision Support 
System (DSS) is a computer-based information 
system that provides a flexible tool for analysis 
and helps managers focus on the future.

	 l	 Executive Support System: An Executive Support 
System (ESS) is an easy-to-use DSS made 
especially for top managers; it specifically 
supports strategic decision making. An ESS is 
also known as Executive Information System 
(EIS).

	 l	 Office Automation System: Office Automation 
System (OAS) combines various technologies 
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to reduce the manual labour required in 
operating an efficient office environment.

	 3.	The application of each type of Information 
system is given below:

	 l	 Transaction Processing System: Transaction 
Processing Systems (TPSs) are designed to 
process routine transactions efficiently and 
accurately. A business will have several 
(sometimes many) TPS; for example:

		  -	 Billing systems to send invoices to 
customers

		  -	 Systems to calculate the weekly and 
monthly payroll and tax payments

		  -	 Production and purchasing systems to 
calculate raw material requirements

		  -	 Stock control systems to process all 
movements into, within and out of the 
business.

	 l	 Management Information System: A Management 
Information System (MIS) is mainly concerned 
with internal sources of information. MIS 
usually takes data from the transaction 
processing systems and summarizes it into 
a series of management reports. MIS reports 
tend to be used by middle management and 
operational supervisors.

	 l	 Decision-Support Systems: Decision-Support 
Systems (DSSs) are specifically designed 
to help management make decisions in 
situations where there is uncertainty about 
the possible outcomes of those decisions. DSS 
comprises tools and techniques to help gather 
relevant information and analyze the options 
and alternatives. DSS often involves use of 
complex spreadsheets and databases to create 
“what-if” models.

	 l	 Executive Support System: An Executive 
Support System (ESS) is designed to help 
senior management make strategic decisions. 
It gathers, analyses and summarizes the key 
internal and external information used in the 
business.

		  A good way to think about an ESS is to 
imagine the senior management team in an 
aircraft cockpit — with the instrument panel 

showing them the status of all the key business 
activities. ESS typically involves lots of data 
analysis and modeling tools such as “what-if” 
analysis to help strategic decision-making.

	 l	 Office Automation Systems: Office Automation 
Systems (OASs) are systems that try to 
improve the productivity of employees 
who need to process data and information. 
Perhaps the best example is the wide range 
of software systems that exist to improve 
the productivity of employees working in an 
office (e.g., Microsoft Office XP) or systems 
that allow employees to work from home or 
whilst on the move.

Suggested Activities

	 Refer to sub-unit 1.2 of the Student Textbook for 
doing the activities.

Answers to Review Questions

Fill in the Blanks

	 1.	 ICT	 2.	 Satellite
	 3.	 information rich society

State Whether True or False

	 1.	False	 2.	 True
	 3.	True	 4.	 False

Multiple Choice Questions

	 1.	 (a)	 2.	 (d)
	 3.	 (b)	 4.	 (c)

Match the Following

	 1.	 (c)	 2.	 (d)
	 3.	 (b)	 4.	 (a)

Answer the Following

	 1.	The increasing use of technology in all aspects of 
society makes confident, creative and productive 
use of ICT an essential skill for life. ICT can 
be used to find, develop, analyse and present 
information, as well as to model situations and 
solve problems. ICT enables rapid access to ideas 
and experiences from a wide range of people, 
communities and cultures, and allows pupils to 
collaborate and exchange information on a wide 
scale.
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		  ICT acts as a powerful force for change in society 
and citizens should have an understanding of the 
social, ethical, legal and economic implications 
of its use, including how to use ICT safely and 
responsibly. Increased capability in the use of ICT 
supports initiative and independent learning, as 
pupils are able to make informed judgements 
about when and where to use ICT to enhance 
their learning and the quality of their work.

		  In everyday life computers, mobile phones and 
satellite broadcasting are very useful to all of 
us. 

	 2.	Digital device:  It is a device that works with 
discrete numbers or digits. For example, Digital 
Computers, Digital Cameras, MP3 players, Mobile 
Chargers, Cell Phones, PDA, GSP portables, 
Mobile VoIP etc.

		  Impact of using computers in offices: Computers 
are forever present in the offices. Computers 
are helpful because they offer a wide range of 
functions and services that are not available 
anywhere else. There are four main uses—word 
processing, Internet/communications, digital 
video/audio composition, and desktop publishing. 
Although one can create a typed paper with a 
typewriter, the computer has more features to 
do it with. Internet and communications, digital 
video and audio composition, and desktop 
publishing are all features that are only offered 
on computers. Electronic mail has made it easy 
to send messages worldwide via computer 
communication networks. With these tools 
human society has progressed exponentially.

		 Office automation has become the term for 
linking workstations, printers, database systems, 
and other tools by means of a local-area network. 
An eventual goal of office automation has 
been termed the paperless office. The increasing 
educational opportunities from the use of 
computers in turn increase the professional job 
opportunities in offices.

	 3.	Use of the Internet and other digital technologies 
has become a necessary tool to function in today’s 
society. Digital divide is the gap that separates 

those who have access to technology and the 
Internet and those who do not.

		 Some of the differences between information poor 
and information rich society are given below:

Information Poor 
Society

Information Rich 
Society

1. Has lower income 
and education level.

1. Has higher income 
and education level.

2. Has no access to 
information, e.g., 
Internet.

2. Has good access to 
information, e.g., 
Internet.

3. Majority of people 
are in developing 
countries.

3. Majority of people 
are in developed 
countries.

4. Cannot use ICT 
applications.

4. Can use ICT 
applications.

5. Do not know 
that ICT can help 
alleviate poverty.

5. Know that ICT 
can help alleviate 
poverty.

Suggested Activity

	 Refer to sub-unit 1.3 of the Student Textbook for 
doing the activity. 

alternative teaching approaches

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Information Systems”.

Additional Questions	

	 1.	Describe applications of ICT in Business, Arts, 
Science, Engineering, Mathematics and Global 
Positioning System (GPS).

	 2.	List the information systems. What commercial 
project management software are suitable for 
information system projects? What are their key 
features?

	 3.	Describe the utility of ICT in everyday life.
	 4.	 Is the gap between Information poor and 

information rich society increasing? Discuss.
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ENHANCING THE
USE OF SOFTWARE

(24 PERIODS)

   UNIT OUTCOME
Students will be able to:

l recognise to choose appropriate software tools to solve problems, illustrate ideas, and clarify thinking in the 
other subjects chosen for study in Grade 11.

suGGested lesson plAn

Sub-unit Number of 
Periods

2.1 Using Application Software 24

struCture of the unit

2.1 using Application Software

In this sub-unit, we will learn about Using Application 
Software. The topics to be learnt are:

 l Word processing,

 m Overview

 m Section breaks

 m Mail merge

 m Header & Footer

 l Presentation Software

 m Overview

 l Spreadsheets,

 m Overview

 m IF condition with AND or OR

 l Publishing Software

 m Overview

 l Database Management

 m Overview

unit 2   

 m Main/Sub reports

 m Group section

review of the unit

 l Word processing program such as MS-Word 2007 
can support photos and drawings, mathematical 
calculations, text in table format, text in varying 
sizes, shapes, colors and  even sound bites.

 l Mail merge is used to create a set of documents, 
such as birthday invitation that is sent to many 
friends and relatives or a sheet of address 
labels.

 l Presentation software such as MS-PowerPoint 
2007 allows users to create slide shows  that can 
be viewed on the computer or projected onto a 
large screen.

 l Spreadsheet software such as MS-Excel 2007 
can be used for both simple and complex  
calculations.

 l Desktop publishing software such as MS-
Publisher 2007 is designed specifically to handle  
various desktop publishing needs of individuals 
and small organization.

 l Database software such as MS-Access 2007 is 
designed to keep track of information.

role of the students

In this unit, the students are supposed to enhance the 
use of software. The activity based method should 
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be followed to understand the subject matter which 
is the best way of better understanding of the subject 
matter.
	 Different type of technologies can be used by 
the students to enhance the use of software. Various 
technologies deliver different kinds of content and 

serve different purposes in the classroom. For example, 
word processing promotes communication skills and 
presentation software promotes presentation skills of 
students. So, it is important for the students to solve 
problems by specific software, illustrate their ideas,  
organize their contents and test their hypotheses.

ADDITIONAL CLASS ACTIVITIES FOR GIFTED STUDENTS OR SLOW LEARNERS

Activity 2.1: Testing the Word Processing Knowledge

Students will answer some Word processing questions to test their knowledge.
Answer the following questions:

Question 1. What is the name of your word processing program?

Question 2. What version of the program are you using?

Question 3. Are there different ways of opening your word processing program?
What are they? 

Question 4. How did you get help on how to use the program? (consider computer, paper-
based and ‘people’ resources)

Question 5. How do you use the Help function?

Question 6. Does the Help function provide a list of keyboard shortcuts and mouse functions?

Question 7. How will you exit from the program?

When you have completed this worksheet, attach it to an e-mail message with the subject line ‘Word Processing 
Activity 2.1 Answers’ and send it to your online teacher.
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Activity 2.2: Testing the Spreadsheet Knowledge

Students will use the words given below to fill in the missing words in the following paragraph. 

columns Sorted formatting cell Rows
text formulas numbers what-if budgets
timetables numerical headings managing A1

Spreadsheets are used for many purposes: ______________, ____________, calculation of ___________ data 
and __________ lists of information. Both ______ and _________ can be entered into a spreadsheet. ________ 
are horizontal and _________ are vertical. A _______ is the intersection between a row and a column. ___ 
is an example of a cell reference. ____________ can be used to calculate values. This makes them useful 
when manipulating data. Text can be used to make __________. __________ can make these headings stand 
out on a page of numbers. Lists of information can be stored in spreadsheets. This has the benefit of being 
easily __________. Once a worksheet has been created, the power and versatility of spreadsheet is to put by 
performing ___________ analyses.   

When you have completed this worksheet, attach it to an e-mail message with the subject line ‘Spreadsheet 
Activity 2.2 Answers’ and send it to your online teacher.

ANSWERS TO review questions

Fill in the Blanks

	 1.	Application Software
	 2.	mail merge
	 3.	Desktop publishing 
	 4.	database

State Whether True or False

	 1.	True	 2.	 False
	 3.	True	 4.	 True

Multiple Choice Questions

	 1.	 (a)	 2.	 (c)
	 3.	 (c)	 4.	 (d)

Match the Following

	 1.	 (c)	 2.	 (d)
	 3.	 (e)	 4.	 (a)
	 5.	 (b)

Answer the Following 

	 1.	Word Processing: It refers to the act of processing 
the textual information including typing, editing, 
formatting and printing.

		 Mail merge in Word 2007: Mail merge is used 
when we want to create a set of documents, such 

as a form letter that is sent to many customers 
or a sheet of address labels. Each letter or label 
has the same kind of information, yet the content 
is unique. For example, in letters to our friends, 
each letter can be personalized to address each 
friend by name. The unique information in 
each letter or label comes from entries in a data 
source.

		 The mail merge steps are:
	 (i)	 Set up the main document. The main document 

contains the text and graphics that are the same 
for each version of the merged document. For 
example, the return address or salutation in a 
form letter. 

	 (ii)	 Connect the document to a data source. A data 
source is a file that contains the information 
to be merged into a document. For example, 
the names and addresses of the recipients of 
a letter. 

	 (iii)	 Refine the list of recipients or items. MS-Word 
generates a copy of the main document for 
each item, or record, in our data file. If our 
data file is a mailing list, these items are 
probably recipients of our mailing. If we want 
to generate copies for only certain items in our 
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data file, we can choose which items (records) 
to include.

	 (iv)	 Add placeholders, called mail merge fields, to 
the document. When we perform the mail 
merge, the mail merge fields are filled with 
information from our data file. 

	 (v)	 Preview and complete the merge. We can preview 
each copy of the document before we print 
the whole set.

		  In Word 2007, we use commands on the Mailings 
tab to perform a mail merge. We can also perform 
a mail merge by using the Mail Merge task pane, 
which leads us step by step through the process. 
To use the task pane, in the Start Mail Merge 
group on the Mailings tab, click Start Mail Merge, 
and then click Step by Step Mail Merge Wizard.

	 2.	To insert an image or clipart in a presentation, perform 
the following steps: 

	 (i)	 Open a presentation. 
	 (ii)	 Click the slide on which you want to insert 

the image or clipart. 
	 (iii)	 Click Insert tab.
	 (iv)	 Click Picture button or Clip Art button. 
	 (v)	 At Insert Picture dialog box, navigate to desired 

folder or at Clip Art task pane, type desired 
category, and then press Enter key. 

	 (vi)	 Double-click the desired picture file or clip art 
image. Arrange the picture or clip art in the 
slide and resize it if necessary. 

	 (vii)	 Save the presentation.
	 3.	Spreadsheet: It is an application software that is 

designed to handle large volumes of business 
and general data. It can be used for calculating 
accounts, managing inventory, managing payroll, 
managing and analyzing the sales and marketing, 
and managing household data like recording 
expenditures.

		  If condition with AND or OR in Excel 2007: We 
can use the AND or OR to create conditional 
formulas. 

		 AND( ): It returns TRUE if all its arguments are 
TRUE; returns FALSE if one or more argument 
is FALSE. The syntax of AND( ) function is: 

		 AND(logical1, logical2, ...) 

		 Here, 
		  logical1, logical2, ... are 1 to 255 conditions you 

want to test that can be either TRUE or FALSE. 
		 For example, 
		 =AND(TRUE,TRUE) will result TRUE. 
		 =AND(TRUE,FALSE) will result FALSE. 
		 =AND(3+4=7,3+5=8) will result TRUE.
		 OR( ): It returns TRUE if any argument is TRUE; 

returns FALSE if all arguments are FALSE. The 
syntax of OR( ) function is:

		 OR(logical1, logical2,...) 
		 Here, 
		  logical1, logical2,... are 1 to 255 conditions you 

want to test that can be either TRUE or FALSE. 
		 For example, 
		 =OR(TRUE) will result TRUE. 
		 =OR(FALSE,FALSE) will result FALSE. 
		 =OR(3+4=8,3+5=9) will result FALSE.
	 4.	MS-Publisher 2007 can create a wide range 

of publications. The names of some of these 
publications are:

	 (i)	 Advertisements
	 (ii)	 Banners
	 (iii)	 Brochures
	 (iv)	 Business Cards
	 (v)	 Calenders
	 (vi)	 Catalogs
	 (vii)	 Flyers 
	 (viii)	 Greeting Cards
	 (ix)	 Invitation Cards
	 (x)	 Resumes
	 (xi)	 Websites etc.
		 To create and save a publication based on a template, 

perform the following steps: 
	 (i)	 Choose a publication type from Publication 

Types in the left pane of the Getting Started 
with Microsoft Office Publisher 2007 window. 

	 (ii)	 In the Publication Types list, click the publication 
category you want.

	 (iii)	 In the right pane, set the publication options 
and then click Create.
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	 	 A publication based on the selected template 
opens in a new Publisher program window.

		  The Publisher program window displays 
all the tools you need to customize the 
publication. You can perform most tasks by 
clicking commands on menus or buttons on 
toolbars. Common tasks are available in the 
Format Publication task pane to left of the 
publication workspace.

	 (iv)	 To save a publication, click Save As on the File 
menu. 

	 (v)	 Click the New Folder button on the toolbar of 
the Save As dialog box. 

	 (vi)	 Type a name for the folder, press Enter key 
and name the file if necessary. 

	 (vii)	 Click Save.
	 5.	Main/subreport in Access 2007: A subreport is a 

report that is inserted in another report. When 
we combine reports, one of them must serve as 
the main report that contains the other report. A 
main report is either bound or unbound. A bound 
report is one that can display data and has a table 
or query specified in its Record Source property. 
An unbound report is one that is not based on a 
table or query (that is, the Record Source property 
of the report is empty).

		 We can create a variety of reports in Access 2007, 
ranging from the simple to the complex. First of 
all choose the report’s record source. Whether 
the report is a simple listing of records or a 
grouped summary of sales by region, we must 
first determine which fields contain the data we 
want to see in our report, and in which tables or 
queries they reside.

		 After we choose the record source, we can create 
the report by using the Report Wizard. The Report 
Wizard is a feature in Access 2007 that guides us 
through a series of questions and then generates 
a report based on our answers.

		 To insert a subreport in a report, perform the following 
steps: 

	 (i)	 Open the main report in Design view. Then 
double-click the Report Selector to display the 
Property sheet pane.

	 (ii)	 On the Data tab, click the Record Source arrow, 
and select the table or query on which the 
subreport will be based. 

	 (iii)	 On the Design contextual tab, in the Controls 
group, click the Subform/Subreport button, and 
then click a point on the main report. The 
SubReport Wizard appears.

	 (iv)	 In the SubReport wizard, with the Use existing 
Tables and Queries option selected, click Next. 

	 (v)	 In the Tables/Queries list, click the source you 
want to use. 

	 (vi)	 In the Available Fields list, double-click the 
fields you want to move them to the Selected 
Fields list, and then click Next. 

	 (vii)	 Click Next and then click Finish. The subreport 
will be inserted in the report.

	 (viii)	 Double-click on the subreport in the Navigation 
Pane to see its contents.

	 (ix)	 Save the subreport.

Suggested Activities

Refer to sub-unit 2.1 of the Student Textbook for 
doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject experts 
can be called for seminars to enrich the teaching level and 
in turn help the students in learning about “Enhancing 
the Use of Software”.

Additional Questions

	 1.	How will you solve problems by specific 
software? Discuss.

	 2.	Describe some popular features of word 
processing and presentation software.

	 3.	Compare and contrast spreadsheets and 
databases.

	 4.	Explain the desktop publishing process and 
describe some of its main features.
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BASIC 
TROUBLESHOOTING

(18 PERIODS)

   UNIT OUTCOME
Students will be able to:

l recognise basic idea in preventive maintenance

l apply the knowledge gained in preventive maintenance to prolong the life of the computer 

l be aware of basic safety issues

l recognise major hardware components inside the computer

l acquire knowledge on how to format hard disk and install software.

suGGested lesson plAn

Sub-units Number of 
Periods

3.1 Basics of Preventive 
Maintenance

6

3.2 Basic Safety Issues 6

3.3 Hardware Maintenance 
Basics

4

3.4 Installing and Uninstalling 
Applications Software

2

struCture of the unit

3.1 Basics of Preventive Maintenance

In this sub-unit, we will learn about basics of preventive 
maintenance. The topics to be learnt are:
 l Environment and location of a computer
 l Electric power
 l Back up methods
 l Manual

unit 3   

 l Using utility programs
 l Improving hard disk performance
 l Disk defragmenter
 l Disk cleanup

3.2 Basic Safety issues 

In this sub-unit, we will learn about basic safety issues. 
The topics to be learnt are:
 l Overview of safety measures
 l Electro Static Discharge (ESD)
 l Hidden ESD
 l Catastrophic ESD
 l Degradation
 l Some common ESD protection devices 
 l Anti-static Wrist and Ankle Straps
 l Anti-static Mats
 l Setting up an Ergonomic Computer and Seating

3.3 Hardware Maintenance Basics

In this sub-unit, we will learn about hardware 
maintenance basics. The topics to be learnt are:

 l Connecting basic input and output devices with 
the system units
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	 l	Checking dead system

	 l	General steps to troubleshoot problems

	 l	Troubleshooting common input and output 
devices

3.4		I nstalling and Uninstalling Applications 
Software

In this sub-unit, we will learn about basics of installing 
and uninstalling application software. The topics to be 
learnt are:
	 l	 Installing application software e.g., Microsoft 

Office
	 l	Uninstalling application software e.g., Microsoft 

Office

Review of the unit

	 l	Computer is a very sensitive device and needs 
to be placed very carefully and its physical 
environment and location requires some special 
arrangements, protections and precautions.

	 l	A backup utility is used to make a backup, or 
duplicate copy, of the information on the hard 
disk. Use defragmenter and disk cleanup to 
improve hard disk performances.

	 l	Electro Static Discharge (ESD) is the release of 
static electricity when two objects come into 

contact. The best method of preventing ESD is 
to use anti-static wrist and ankle straps, or use a 
grounding mat or table.

	 l	Eyestrain usually arise because of improper 
lighting, screen glare, and long shifts starting at 
the screen.

	 l	We must know how to plug properly input 
and output devices with a system and their 
troubleshooting.

	 l	We must know how to install and uninstall 
application software.

ROLE OF THE STUDENTS

In this unit, the students are supposed to learn the 
basic troubleshooting. The activity-based method 
should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter.
	 The students should learn about the computer 
troubleshooting tips, how to fix hardware errors, and 
how to fix the software errors. Troubleshooting the 
computer problems is very vital for students. Every 
hardware component in the computer system has 
its own configuration methods and troubleshooting 
techniques. The students use a computer at their home 
or in school. They must be aware of the diagnostic 
procedures and troubleshooting of the basic computer 
problems.

ADDITIONAL CLASS ACTIVITIES FOR GIFTED STUDENTS OR SLOW LEARNERS

Activity 3.1: Preventive Maintenance Procedures

In small groups, the students will practise as the teacher instructs about preventive maintenance 
procedures.

Preventive Maintenance Procedures

To prolong the life of your PC, you simply must inspect and clean it regularly. Cleaning your PC on a regular 
basis can prevent overheating and Electro Static Discharge (ESD).

Fig. 3.1: Maintenance of PC—prolongs its life
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During the inspection process, look for damaged or cracked components, improperly seated components, 
frayed cables, and loose connections.

Cleaning Tools

Many products are available to help improve the process of cleaning your computer and peripherals. You 
can also use household items to clean the computers and peripherals. Remember that some components in 
your computer may only be able to be cleaned using a product designed for cleaning that component. Some 
cleaning tools are cloth, water or rubbing alcohol, portable vacuum cleaner, cotton swabs, foam swabs etc.
	 You should use a cloth when cleaning components such as the outside of the case, a drive, mouse, etc. Do 
not use a cloth to clean any circuitry such as the RAM or motherboard since it can generate ESD that can 
damage electronic components.

Compressed Air

Compressed air works well for getting the dust out of power supply fans, expansion slots, and keyboards, 
but you need to exercise care in using it for blowing the dust off components and the inside of the case. It is 
not uncommon to blow the dust off one component right onto another component.
	 You also need to exercise extreme care when using compressed air, because the liquid that compresses the 
air sits in the bottom of the can and is usually not released unless you turn the can upside down or sideways. 
This liquid can damage or destroy your components.

Liquid Cleaning Compounds

Before using any liquid cleaning compound, make sure that your computer is turned off. If the PC has 
power when you use liquid cleaners, you run the risk of frying or shorting out your components, which 
is an expensive risk to take. Also make sure that the component you have cleaned with a liquid cleaner is 
thoroughly dry before turning your computer back on!

Clean or Soapy Water and a Damp Cloth

In some cases, you need only a bit of water and a damp cloth for cleaning chores, such as when cleaning the 
mouse ball, the outside of the mouse, or the exterior of the monitor or computer case. If water alone cannot 
do the job thoroughly, you can use mild soapy water on your damp cloth. Make sure that the cloth is damp 
and not wet and that you do not splash or drip water into your components.
	 If the keys on your keyboard start to stick or you have spilled a cup of coffee into your keyboard, or, for 
that matter, you just know that there is a lot of dirt under the keys; you can clean the keyboard with distilled 
water. Some techs will use a light silicone spray lubricant, but I find that water does as good a job. Keep in 
mind that if you want your keyboard to work again, you need to make sure that it’s unplugged before you 
clean it and that it is thoroughly dry before you plug it in again. As a general rule, wait at least 48 hours 
before re-attaching the keyboard to your system.

Glass Cleaner

You need to turn your monitor off before cleaning to avoid damage to the screen. Many technicians clean the 
monitor screen with regular cleaner. Under most circumstances, however, water and a damp cloth will do the 
job just fine. Water is the safest cleaning liquid your can use on a monitor. When cleaning the LCD display 
screen of a laptop, do not use glass cleaner at all. You will melt the screen!

Lint-Free Cloths

Lint-free cloths are excellent for removing dust from your computer. The cloths used for cleaning eyeglasses 
work the best, because they will not scratch the surfaces or leave lint behind.
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Activity 3.2: Disk Defragmentation

In small groups, students will explain and demonstrate about disk defragmentation.

Disk Defragmentation Utility Software

When computer system finds a file too large to store in a single location, it splits the file and stores it in 
pieces (called fragments), which are logically linked. This simply means that different parts of the file are 
scattered across the hard drive in non-contiguous locations. This type of fragmented file requires some extra 
time to access and slows down the system. Disk defragmentation utility software speeds up the system by 
rearranging such fragmented files stored on a disk in contiguous location in order to optimize the system 
performance. For example, if you have three defragmented files named 1 (stored in 6 fragments), 2 (stored 
in 4 fragments) and 3 (stored in 5 fragments) as shown in Fig. 3.2, then running the defragmentation utility 
will reorganize the file contents in consecutive locations as shown in Fig. 3.2.

1 1 1 2 2 1 1 1 1 1

3 3 1 2 Free 1 2 2 2 2

Free Free 2 2 Free 3 3 3 3 3

3 3 3 Free 1 Free Free Free Free Free

	 Example of a Fragmented Drive	 Example of a Defragmented Drive

Fig. 3.2: A simple Visualization of Disk Fragmentation

You should regularly get defragmented your hard drive so as to increase the speed of accessing files thereby 
improving the system performance.

ANSWERS TO review questions

Fill in the Blanks

	 1.	Computer
	 2.	Electro Static Discharge (ESD)
	 3.	 input, output
	 4.	Ergonomics

State Whether True or False

	 1.	False	 2.	 True
	 3.	True	 4.	 False

Multiple Choice Questions

	 1.	 (d)	 2.	 (a)
	 3.	 (d)	 4.	 (b)

Match the Following

	 1.	 (c)	 2.	 (a)
	 3.	 (d)	 4.	 (b)

Answer the Following

	 1.	Computer is a very sensitive device and needs to 
be placed very carefully. Its physical environment 
and location requires some special arrangements, 
protections and precautions. These precautions 
and protections are not only necessary for 
computers but are equally important for computer 
users.

		  In order to ensure troublefree, prolonged life and 
smooth working of a computer, you must take 
into consideration that dust-free environment 
and proper location are maintained for it. You 
must take care of the following: 

	 (i)	 Always place your computer in an open area 
that allows adequate airflow.

	 (ii)	 Keep the computer in a cool, dry and  
dust-free environment.
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	 (iii)	 Keep level, stable floors and tables.
	 (iv)	 Arrange ergonomic furniture.
	 (v)	 Keep precautionary fire prevention 

equipment.
	 (vi)	 Must have static electricity.
	 (vii)	 Keep the computer safe from vibrations.
		 For setting up an ergonomic computer, you must 

take care of the following: 
	 (i)	 Guarding against hardware theft and loss.
	 (ii)	 Guarding against heat, cold, spills and 

drops. 
	 (iii)	 Guarding against damage to software. 
	 (iv)	 Protecting the data. 
		 More important than any computer system and 

(probably) any data is computer user’s health. 
The most serious effects are painful hand and 
wrist injuries, eyestrain and headache, and back 
and neck pains. You can avoid most of these 
problems, if not all, by sitting properly.

		 Eyestrain usually arises because of improper 
lighting, screen glare, and long shifts staring 
at the screen. Make sure that the windows and 
lights do not throw a glare on the screen and 
that the computer is not framed by an uncovered 
window.

	 2.	Computers need electric power to work, but it 
can harm a PC or its data if it does not flow 
properly. The electricity available from a standard 
wall outlet is Alternating Current (AC), but a PC 
runs on Direct Current (DC). The power supply 
is a device that converts AC to DC to run the 
computer. The on/off switch in your computer 
turns on or shuts off the electricity to the power 
supply. 

		 Your computer needs good power to run properly, 
but various factors can take what should be a 
steady stream of electricity from the wall socket 
and turn it into a trickle or a fire hose. It is 
important that you know how to protect your 
computing environment from electrical power 
sags and power losses, power spikes, lightning 
strikes, and electromagnetic interference. 

			  Instead of plugging your computer directly into 
the wall electrical outlet, it is a good idea to plug 
it into a power protection device such as surge 

protector, voltage regulator, UPS (Uninterruptible 
Power Supply).

		 Use a stabilizer to ensure the level of voltage being 
supplied at a desired level: Plug your computer 
into a stabilizer to adjust for power variations, 
which will deliver a consistent voltage level to 
the equipment. Power fluctuations can cause 
damage to electrical motors and components. 
This damage could be severe and immediate, or 
it could result in a shorter operating lifespan.

		 Consider using a UPS to protect against complete 
absence of electricity: Consider plugging 
your computer into a UPS (Uninterruptible 
Power Supply). The UPS is kind of a short-
term battery that, when the power fails, will 
keep your computer running long enough  
(5–30 minutes) for you to save your data before 
you turn off the computer. It also acts as a surge 
protector.

	 3.	Diskfragmenter: When you delete old files from 
your hard disk and add new ones, something 
happens: The files become fragmented. 
Fragmentation is the scattering of portions of files 
about the disk in nonadjacent areas, thus greatly 
slowing access to the files.

		 When a hard disk is new, the operating system 
puts files on the disk contiguously (next to one 
another). However, as you update a file over time, 
new data for that file is distributed to unused 
spaces. These spaces may not be contiguous to 
the older data in that file. It takes the operating 
system longer to read these fragmented files. 
A defragmenter utility program, commonly called a 
“defragger,” will find all the scattered files on your 
hard disk and reorganize them as contiguous files. 
Defragmenting the files will speed up the drive’s 
operation.

		 Disk Cleanup: The disk cleanup utilities can 
search for and remove unnecessary files, such as 
temporary files, or “temp files”. Both Windows 
and the applications you run create temp files 
needed only for short tasks and system restore 
(return to normal operating conditions) after 
certain types of system problems. These files are 
stored in the Temp folder. For example, when 
you create a word document, Word will store a 
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between people and machines. The purpose 
of ergonomics is to make working conditions 
and equipment safer and more efficient. It is 
concerned with designing hardware and software 
that is less stressful and more comfortable to use, 
that blends more smoothly with a person’s body 
or actions. Examples of ergonomic hardware are 
tilting display screens, detachable keyboards, 
and keyboards hinged in the middle to allow the 
users’ wrists to rest in a more natural position.

		 More important than any computer system and 
(probably) any data is computer user’s health. 
The most serious effects are painful hand and 
wrist injuries, eyestrain and headache, and back 
and neck pains. You can avoid most of these 
problems, if not all, by sitting properly.

		  Figure 3.3 shows the correct sitting posture:

Fig. 3.3: Correct sitting posture

temp file version of it in the Temp folder. When 
you save this document, Word will save it to the 
location you designated and delete the temp file. 
The computer should delete temp files when a 
program is closed, but this does not always 
happen. Also, files will be left in the Temp 
folder if the computer crashes. Thus temp files 
can accumulate in the Temp folder and take up 
space.

		  In Windows XP, run Disk Cleanup to determine 
how much hard disk space you can free up. Then 
choose which files to get rid of.

		 To use Windows Disk Cleanup,
		 Click Start → All Programs → Accessories → System 

Tools → Disk Cleanup
	 4.	Ergonomically correct computer and seating: 

Ergonomics is the study of the interaction 
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	 5.	The knowledge about installing and uninstalling 
application software plays an important role in 
basic troubleshooting of the computer. If you do 
not know about it, then call tech support. 

		 Steps for installing application software: You will 
need the Readme instructions, the disk containing 
the program, and perhaps the serial number or 
key of either the software being installed or your 
computer.

	 (i)	 Read Readme (The piece of paper available 
with the software or a file on the software 
CD).

	 (ii)	 Insert the Install disk in the computer’s  
CD-ROM drive.

	 (iii)	 Follow the instructions (The serial number of 
key will be in the box of software, or inside 
the manual).

	 (iv)	 Keep going until installation is over (Choose 
the default options, which will reinstate 
the conditions that were standard with the 
program as you purchased it).

	 (v)	 Reboot the system, if necessary.
		 Steps for uninstalling application software: There are 

several reasons why you may want to uninstall 
application software from your computer. It could 
be that the software is no longer being used and 
is unnecessary, it conflicts with other programs, 
it is not functioning as expected or you just want 
to free up some space on your computer’s hard 
drive. Whatever the reason, it is not difficult to 
uninstall a software.

	 (i)	 Click Start → Control Panel.
	 (ii)	 Open the Add and Remove Programs dialog box 

in Control Panel.

	 (iii)	 Select the desired application which you want 
to uninstall. Click Remove button.

	 (iv)	 Click OK button to confirm the removal of 
application software.

	 (v)	 Uninstalling process will start.
	 (vi)	 After few minutes, the application software 

will be successfully uninstalled. 
	 (vii)	 After completion of setup, you may be asked 

for rebooting the system. Reboot the system, 
if necessary.

Suggested Activities

Refer to sub-units 3.1 to 3.4 of the Student Textbook 
for doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Basic Troubleshooting”.

Additional Questions

	 1.	How will you back up files stored in the 
computer?

	 2.	Define Electro Static Discharge (ESD) and identify 
some ESD types. Also list some ESD protection 
devices.

	 3.	Describe the general steps to troubleshoot 
problems.

	 4.	How will you troubleshoot minor problems 
related with some common input and output 
devices? 
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EXPLOITING THE 
INTERNET

(18 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l find specific information on the world wide web in the form of text, images or sound required to solve 
a problem

 l develop an awareness of web developments in making information available in different formats.

suGGested lesson plAn

Sub-units Number of
 Periods

4.1 Advanced Searching 4

4.2 Using Wikis, Blogs and Podcasts 4

4.3 Social Networking 2

4.4 Producing a Webpage Using Simple 
Web Design Software

4

4.5 Publishing to a Web Server (or free Web 
Server or a Wikipedia Web Server)

4

struCture of the unit

4.1 Advanced Searching 

In this sub-unit, we will learn about advanced 
searching. The topics to be learnt are:
Exact match
 l “x” or “y” l “x” and “y”
 l “x” but “y” l Language limitations

4.2 using wikis, Blogs and Podcasts 

In this sub-unit, we will learn about using Wikis, Blogs 
and Podcasts. 

unit 4   

4.3 Social networking 

In this sub-unit, we will learn about social 
networking. 

4.4 Producing a webpage using simple web 
design software

In this sub-unit, we will learn about producing a 
Webpage using simple Web design software.

4.5 Publishing to a web Server (or free web 
Server or a wikipedia web Server)

In this sub-unit, we will learn about publishing to a 
Web Server (or free Web Server or a Wikipedia Web 
Server).

review of the unit

 l Nearly all search engines have an advanced 
search option.

 l Wikis are webpages that can be viewed and 
modified by anyone with a web browser and 
Internet access.

 l Many users of the Internet have fun keeping 
journals, or web logs—called blogs for short—
accessible to users.

 l Podcasts are online broadcasts that can be 
downloaded to portable devices.
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 l Social networking is the grouping of individuals 
or organizations into specific groups.

 l We can produce a webpage using simple web 
design software and publish it to a web server.

role of the students

In this unit, the students are supposed to learn about 
exploiting the Internet. The activity based method 
should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter.

 The Internet is an extremely useful resource for 
students. There is a lot of information on the World 
Wide Web in the form of text, images or sound 
which can help students in solving problems. They 
must be very careful while using information from 
the Internet. Students should also learn important 
multimedia skills and how to share their creations 
through read/write Web tools such as blogs, wikis, 
podcasts, and social networks. They should produce 
a webpage using Web design and publish it to a web 
server.

AdditionAl ClAss ACtivity for Gifted students or slow leArners

Activity 4.1: internet Protocols

Teacher will explain and demonstrate to students about Internet protocols.

Internet

The Internet is a global system of interconnected computer networks that uses the standard Internet Protocol 
Suite (TCP/IP) to share information over billions of users worldwide.
 The Internet carries a vast range of information resources and services, such as the inter-linked hypertext 
documents of the World Wide Web (WWW) and the infrastructure to support e-mail. Figure 4.1 shows Internet 
Explorer browser, for surfing the Internet.

Fig. 4.1: Internet Explorer for surfing the Internet

Internet Protocols 

A protocol is a set of rules which is used by computers to communicate with each other across a network. 
There are a number of protocols used in computing. The most popular ones are:

TCP/IP
One of the most common ways used by computers to send information across the Internet is by using two 
protocols (called TCP and IP) together.
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TCP (Transmission Control Protocol)
It adds extra information to each packet to make sure that when they are received at the destination computer 
(by using IP) they have not been damaged, none of them are missing, and they are all put back together in 
the right order. If any packets are missing or damaged, a request is sent back to re-send those packets before 
the information is reassembled.

IP (Internet Protocol)
It works by giving each machine on the internet a unique 12 digit IP address (like 142.109.265.155). When a 
computer wants to send information across the internet, the information is broken into small segments called 
packets, and each packet is stamped with a “to” and “from” IP address. The packets are then sent across the 
internet to their destination.

HTTP  (Hyper Text Transfer Protocol)
It means pages automatically load (automatically saved in cache instead of asking you where you want to 
save it). Original use of http was to give people a way to publish and retrieve hypertext pages within the 
Internet.

FTP (File Transfer Protocol)
It is used to transfer files over a network to other computers. The difference from http is that you indicate 
where you want to save the files to (or upload them from).
	 Files offered cover nearly anything that can be stored in a computer. For example, photos, gaming, music 
and statistics.

POP3 (Post Office Protocol 3)
POP3 is an internet-based standard for retrieval of e-mail by a user from an e-mail server. POP stands for 
Post Office Protocol. The “3” means it is the third revision of the standard.

ANSWERS TO review questions

Fill in the Blanks

	 1.	 search engines
	 2.	Wikis
	 3.	Podcasts
	 4.	Facebook, Twitter, Orkut

State Whether True or False

	 1.	False	 2.	 True
	 3.	True	 4.	 False

Multiple Choice Questions

	 1.	 (c)	 2.	 (d)
	 3.	 (a)	 4.	 (c)

Match the Following

	 1.	 (d)	 2.	 (c)
	 3.	 (b)	 4.	 (a)

Answer the Following

	 1.	Using the Boolean searching techniques: Boolean 
search techniques can be used to carry out 
effective searches, cutting out many unrelated 
documents. You can broaden or narrow your 
search by combining words or phrases using the 
Boolean operators AND, OR, and NOT.

		 The AND operator narrows a search, the OR 
operator broadens a search, and NOT operator 
excludes material from a search.

		  Improvements: Many  search engines have an 
Advanced Search  interface that allows for 
Boolean searching; you can also try just using 
a Boolean operator in the main search box. For 
example, the search engines Google and Yahoo 
provide advanced web searching methods.

		 To open Google Advanced Search form, click on the 
Advanced Search hyperlink on the right side of the 
Google Search box at www.google.com.
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		 Now, you can use the Google Advanced Search form 
for advanced searching. Type the desired search 
topic and press Advanced Search button, your 
advanced search will appear on the screen.

		 To open Yahoo Advanced Web Search page go to 
www.yahoo.com, click the down arrow in More 
option above the Yahoo Web Search box, then from 
the menu that appears click the Advanced Search 
hyperlink. 

			  Now, you can use the options on the Yahoo 
Advanced Web Search page to create a very 
specific search. Just fill in the fields you need for 
your current search and click the Yahoo! Search 
button, your advanced search will appear on the 
screen.

	 2.	Wikis: These are Webpages that can be viewed 
and modified by anyone with a Web browser 
and Internet access.

		 A wiki is a website that allows the creation and 
editing of any number of interlinked webpages 
via a web browser using a simplified markup 
language or a WYSIWYG text editor. Wikis 
are typically powered by wiki software and 
are often used to create collaborative works. 
For example, community websites, corporate 
intranets, knowledge management systems, and 
note services. The software can also be used for 
personal note taking. Wikipedia is a well known 
wiki.

		 Advantages: Some advantages of using a wiki 
are: 

	 (i)	 Anyone can edit. 
	 (ii)	 Easy to use and learn. 
	 (iii)	 Wikis are instantaneous so there is no need to 

wait for a publisher to create a new edition or 
update information. 

	 (iv)	 People located in different parts of the world 
can work on the same document. 

	 (v)	 The wiki software keeps track of every edit 
made and it is a simple process to revert back 
to a previous version of an article. 

	 (vi)	 Widens access to the power of web publishing 
to non-technical users. 

	 (vii)	 The wiki has no predetermined structure—
consequently it is a flexible tool which can be 
used for a wide range of applications. 

	 (viii)	 There is a wide range of open source software 
wiki has to choose from so licensing costs 
should not be a barrier to installing an 
institutional wiki.

		 Disadvantages: Some disadvantages of using a 
wiki are:

	 (i)	 It can get messy, especially in big projects 
where a large number of people contribute.

	 (ii)	 It requires some maintenance otherwise it will 
become unstable.

	 (iii)	 The content management system is not 
good.

		 Blogs: Many users of the Internet have fun 
keeping journals, or web logs—called blogs for 
short, accessible to users. Blogs are often updated 
daily and reflect the personality and views of 
a blogger. Blog sites—for example, blogging 
network (www.bloggingnetwork.com) and Pyra 
Labs (www.blogger.com)—provide information 
about how you can create and maintain your 
own web log for a small fee.

		 Advantages: Some advantages of blogs are: 
	 (i)	 Blog sites can be developed with the help of 

simple procedures. 
	 (ii)	 A blog post goes public, in other words, it can 

be accessed and read by almost everyone who 
has an access to Internet. 

	 (iii)	 The usage of blogs are very convenient, hence 
people tend to use them more frequently. 

	 (iv)	 Students tend to improve their writing skills 
as blog articles should be reasonably good 
enough and free from grammatical mistakes. 

	 (v)	 Students get into the habit of writing, which 
helps them in all their future endeavours. 

	 (vi)	 Blog sites used as online class forums enable 
students to interact with various personalities 
to participate in a discussion far more 
effectively than they can otherwise. 

	 (vii)	 Individuals learn to express their opinions and 
exchange their views on topics of common 
interest, which not only keeps them updated 
but also makes them effective contributors of 
new ideas.

	 (viii)	 Individuals get a chance to read other blogs, 
which indirectly helps them to improve upon 
their skill of writing. 
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	 (ix)	 Instructors of online classes get an opportunity 
to know what students feel about the class 
and its presentation quality and help to find 
ways to improve upon drawbacks if any. 

	 (x)	 It is a place for students and individuals to 
share their articles and opinions with people 
outside their community.

		 Disadvantages: Some disadvantages of blogs are: 
	 (i)	 It involves a lot of time to update and post an 

entry on the blog site.
	 (ii)	 Regular writing may give rise to slangs and 

sloppy way of writing, spoiling the quality of 
proper usage of language.

	 (iii)	 One major drawback is that not all information 
can be shared on blog sites. Hence, may not 
be useful for everyone.

	 (iv)	 Individuals and students may have 
reluctance in getting used to the technological 
advancements.

	 (v)	 Blogging cannot be thrusted upon students 
who are hardly interested in reading and 
replying to the post.

	 (vi)	 Blogging on day-to-day issues is different 
from writing on a subject. Hence it may not 
be a practical idea to force students to do it.

	 (vii)	 There is no confidentiality as it is a public 
forum.

	 (viii)	 It is not suited for issues requiring immediate 
solution.

	 (ix)	 Blogs create a sense of students competing 
with each other just for posting entries. The 
fear of students getting diverted away from 
the subject is an issue of concern.

		 Podcasts: These are online broadcasts that you 
can download to portable devices. It is a piece 
of audio (usually an MP3 file) that can be 
automatically delivered to your computer, for 
you to listen to at your convenience. It might be 
a professional radio programme, a film review, 
a language lesson, a daily recipe. Whatever your 
interests, you are likely to find a podcast to fit 
the bill. 

		 Podcasting lets you automatically receive the 
latest episode of your chosen programme as 
soon as it is available. With our current range 

of audio podcasts, you can take your favourite 
radio programmes with you on the move and 
listen wherever and whenever you like. 

		 You can “subscribe” to receive a podcast, rather 
like you might subscribe to a magazine and 
get it delivered each week. For example, all of 
the BBC’s podcasts are free, and you can stop 
receiving the files at any time. If you would 
rather not subscribe, you can download episodes 
of a podcast series individually.

		  In order to subscribe for a podcast, you need 
an Internet connection and a piece of podcast 
software which is usually available free of 
charge. Once you have installed this software, 
it will check the podcast for new episodes of 
your chosen podcast series and automatically 
download new episodes for you. 

		 You can then listen to podcast episodes on your 
computer, or transfer them to a portable device, 
such as an MP3 player.

		 Advantages: Some advantages of podcasts are: 
	 (i)	 Available anytime/anywhere for students. 
	 (ii)	 Easy to create, distribute, and download—no 

professional equipment is required. 
	 (iii)	 New podcasts are auto-downloaded. 
	 (iv)	 Can restrict podcasts to students enrolled in 

the course. 
	 (v)	 Power of audio over text—students can listen 

and learn while walking, riding, waiting in 
line, etc.

		 Disadvantages: Some disadvantages of podcasts 
are: 

	 (i)	 Entire file is downloaded to user’s computer/
device.

	 (ii)	 Need sufficient bandwidth to download the 
podcasts in a timely fashion.

	 (iii)	 Limited usefulness for hearing impaired 
people.

	 (iv)	 No interactivity—audience cannot participate, 
etc.

	 (v)	 Intellectual property issues.
	 3.	Social Networking: Social networking is the 

grouping of individuals or organizations into 
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specific groups. Although social networking is 
possible in person, especially in the workplace, 
universities, and high schools, it is most popular 
online. This means that although you are in 
Ethiopia, you could develop an online friendship 
with someone in India or USA. 

		  Initially social networking was an initiative to 
communicate amongst known and unknown users 
working over network worldwide. It has now 
turned into a much matured area to explore and 
exploit experiences and experties of individuals 
sitting miles and miles away from each other. 
It gives a common platform to find people of 
varied interests and social backgrounds.

		 A number of people utilize the services of social 
networking sites as a common place to develop 
group projects on various subjects. It also helps to 
find out alumni and old friends and also allows 
you to contact and start fresh conversations. 
It creates an extended network by connecting 
friends of friends and further enabling the 
empowerment of knowledge and resources. The 
social networking websites are known as social 
sites. Some of the common social networking 
sites are Facebook, Twitter, Netlog, Hi5, Orkut, 
etc.

		 As mentioned earlier, social networking often 
involves grouping specific individuals or 
organizations together. While there are a number 
of social networking websites that focus on 
particular interests, there are others that do not. 
The websites without a main focus are often 
referred to as “traditional” social networking 
websites and usually have open memberships. 
This means that anyone can become a member, 
no matter what his hobbies, beliefs, or views 
are. However, once you are inside this online 
community, you can begin to create your own 
network of friends and eliminate members that 
do not share common interests or goals. 

		 Although the idea of online social networking 
sounds very useful but there is certain element 
of risk and danger involved in it. Through 
networking you not only communicate with your 

known ones but also to strangers and revealing 
your personal details to strangers can sometimes 
be very dangerous. Sometimes a stranger may 
pretend to be someone which he is not in reality. 
But then this type of risk is involved in real 
world too. Everyday, for the business purpose 
or otherwise, one has to meet and interact 
with many unknown people. In such situations 
we use our wisdom to calculate how much of 
ourselves to reveal before him. Similarly, while 
interacting online, one should use his inner 
voice to react accordingly. The other type of risk 
involved in social networking is hacking. Even 
if you are interacting with known people, your 
information and personal details can be hacked 
by hackers. So one has to be cautious and supply 
only minimum required details.

	 4.	MS-Publisher 2007 is an excellent authoring tool 
to use when you want to quickly create, publish, 
and manage simple Webpage. 

		 To create a webpage, perform the following 
steps: 

	 (i)	 Start Publisher. 
	 (ii)	 On the File menu, click New. 
	 (iii)	 In the Publication Types list, click Web Sites. 

Select any web design template from the 
Newer Designs.

	 (iv)	 Click Create. 
	 (v)	 The Easy Web Site Builder dialog box appears.
	 (vi)	 Click OK. 
	 (vii)	 Add content to your publication, and make 

any changes that you want.
	 (viii)	 Click Webpage Preview in Web Tools or on the 

File menu, click Webpage Preview.
	 (ix)	 The webpage is shown in your default 

browser.

	 (x)	 Close the browser.

Suggested Activities

Refer to sub-units 4.1 to 4.5 of the Student Textbook 
for doing Activities 1, 2, 4 and 5.
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Activity 3: View and Listen to a Podcast, e.g., BBC

Teacher will explain and demonstrate to students about viewing and listening to a Podcast, e.g. BBC.

Podcast

A podcast describes a very simple concept: an audio or video file available on the Internet for you to listen to 
and/or watch. A podcast can also refer to a series of these audio or video files (similar to how a TV or radio 
“show” can be a series of shows or just one show). When using the word podcast, most people refer to the 
entire series and not just one audio or video file.

Viewing and listening to podcasts

It is best to listen to podcasts on an iPod or mp3 player which you can take with you wherever you are. 
Setting it up takes a few steps and once you have done that, everything is automated.

	 1.	 The easiest podcast application to use is iTunes - but remember that there are other options. Go to the 
Apple iTunes store and you will see the prominent section to Download iTunes, which will take you a 
page explaining what iTunes is with instructions. When you are ready, click the Download Now button 
on that page and follow the instructions.

	 2.	 Once iTunes is downloaded, open it up and go the iTunes Store. You will see a virtual store where you 
can download music, videos, podcasts and audiobooks - some of which are free and some are paid-
for. 

	 3.	 To find the Fusion View podcast in the iTunes Store, the easiest thing to do is to go to the Search box 
in the top right corner and type in Fusion View. My podcast will come up - click on that to see the 
episodes. Click Subscribe and iTunes will download the latest episode. In future, any time you open 
up iTunes, it will download the latest episode since your last download.

		  You can also click on the Subscribe with iTunes button  on the podcast posts.

		  Clicking on the above button will open up iTunes and subscribe to the Fusion View podcast 
automatically.

		  Many other podcasters have this or similar logos on their blogs so clicking on that will automatically 
subscribe you to their podcasts using iTunes. 

	 4.	 If you want to get previous episodes on my podcast, go to the Library section of iTunes (left sidebar), 
click on Podcasts. This will take you to your library of podcasts that you have subscribed to. Click on 
Fusion View in the list of your podcasts and you will see a drop down list of previous podcasts in 
pale grey text to indicate that you have not downloaded them yet. Click on the “Get” button alongside 
whichever episodes you want to download.

	 5.	 To transfer podcasts from your iTunes library to your iPod or mp3 player, plug that device into your 
computer with iTunes open. iTunes should automatically recognise the device and take you through 
the steps to make the connection and download items from iTunes to the device.

	 6.	 Every time you then plug in your iPod or mp3 player to your computer, iTunes should automatically 
open up and transfer the latest episodes of podcasts you have subscribed to across to your device.
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BBC Podcast

There are great podcasts to download from the BBC. Figure 4.2 shows BBC podcast:

Fig. 4.2: BBC Podcast

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject experts 
can be called for seminars to enrich the teaching level and 
in turn help the students in learning about “Exploiting 
the Internet”.

Additional Questions

	 1.	How will you search the Internet? Discuss.
	 2.	How Internet can be used to study ICT? 

Discuss.

	 3.	Write short notes on the following Internet 
resources:

	 (i)	 File Transfer Protocol (FTP)
	 (ii)	 Telnet
	 (iii)	 Newsgroups
	 (iv)	 Real-time chat.
	 4.	List some advantages and disadvantages of social 

networking.
	 5.	How will you design a simple webpage? 

Explain.
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IMAGE PROCESSING AND 
MULTIMEDIA SYSTEMS

(27 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand the concept of image processing
 l differentiate image file format
 l recognize the function of image processing software
 l recognize interface layout of image processing software
 l edit images properly using image processing software.

suGGested lesson plAn

Sub-units Number of 
Periods

5.1 Overview of Image Processing 6

5.2 Basics of Image Processing 10

5.3 Basic Image Editing (cropping, 
resizing, correcting, sharpening/
softening)

11

struCture of the unit

5.1 overview of image Processing

In this sub-unit, we will have an overview of image 
processing. The topics to be learnt are:

 l Overview of image processing

 l Definition of image processing

 l Image processing software

 l Image file format

unit 5   

5.2 Basics of image Processing  

In this sub-unit, we will learn basics of image 
processing. The topics to be learnt are:

 l Getting started

 l Opening new document

 l Setting up a document

 l Creating an image

 l Saving image document

 l Interface layout

 l Inserting image from a file or other devices

5.3 Basic image Editing (cropping, resizing, 
correcting, sharpening/softening)

In this sub-unit, we will learn about basic image 
editing. The topics to be learnt are:
 l Basic image editing

 l Cropping

 l Resizing

 l Correcting
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	 l	Sharpening/Softening
	 m	 Sharpening 
	 m	 Softening

Review of the unit

	 l	Pixel is the term used most widely to denote the 
elements of a digital image.

	 l	 Image processing is the set of computational 
techniques for analyzing, enhancing, compressing, 
and reconstructing images, generally with a 
digital computer.

	 l	Photoshop is a popular image processing software 
that provides numerous tools for editing an 
image.

	 l	The basic image editing techniques are useful 
when working with digital scans of images. 
We can apply these basic techniques in a wide 
variety of image editing situations.

	 l	Cropping is the process of removing portions 
of an image to create focus or strengthen the 
composition.

ROLE OF THE STUDENTS

In this unit, the students are supposed to learn image 
processing and multimedia. The activity based method 
should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter.
	 Digital image processing enables us to get the 
best quality pictures. It is all about enhancing various 
features of an image. In today’s computers, media 
information such as audio, images, and video have 
become necessary for daily business operations and 
entertainment. So, the students should study the basic 
digital image processing techniques.  They should also 
know the basic components of multimedia and have 
skills to work with them.

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

Activity 5.1: Basic Concepts of Multimedia

Teacher will explain and demonstrate basic concepts of multimedia.

What is Multimedia?

It is any combination of text, art, sound, animation, and video delivered to you by computer or other electronic 
or digitally manipulated means. Figure 5.1 shows multimedia elements.

Fig. 5.1: Multimedia Elements

Multimedia Computer System 

A multimedia computer system is one that can create, import, integrate, store, retrieve, edit, and delete two or 
more types of media materials in digital form, such as audio, image, full motion video, and text information. 
Figure 5.2 shows a multimedia computer system.
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Fig. 5.2: Multimedia Computer System

Primary Multimedia Delivery Media

Multimedia projects often require a large amount of digital memory; hence they are often stored on CD-ROM 
or DVDs. Multimedia also includes webpages in HTML or DHTML (XML) on the World Wide Web.

Areas of Use

Multimedia is appropriate wherever a person interacts with electronic information. The areas in which 
multimedia presentations are suitable include education, training, marketing, advertising, product demos, 
databases, catalogs, entertainment, and networked communications.

ANSWERS TO review Questions

Fill in the Blanks

	 1.	digital image processing
	 2.	 Image processing
	 3.	Cropping	 4.	 Resizing

State Whether True or False

	 1.	True	 2.	 False
	 3.	True	 4.	 False

Multiple Choice Questions

	 1.	 (d)	 2.	 (d)
	 3.	 (c)	 4.	 (a)

Match the Following
	 1.	 (b)	 2.	 (a)
	 3.	 (d)	 4.	 (c)

Answer the Following

	 1.	Image Processing: It is the set of computational 
techniques for analyzing, enhancing, 
compressing, and reconstructing images, 
generally with a digital computer.

		 Image File Formats: We can use a variety of file 
formats in image processing and multimedia 
systems. Some of the more common formats are:

		 GIF (Graphics Interchange Format): It is pronounced 
“jif”, supports upto 256 colors (8 bits per pixel). 
It is a compressed format that keeps file sizes 
smaller. This format is widely used on the Web 
since files can be sent faster than many other 
formats and groups of them can be animated. 
Files in this format have the extension .gif.

		 JPEG ( Joint Picture Experts Group): It is pronounced 
“jay peg”. It supports 16.7 million colors (24 bits 
per pixel). The images are in compressed format 
so file sizes are even smaller than GIF files. Files 
in this format have the extension .jpg.

		 BMP (Bitmap): It is a standard uncompressed 
format for Microsoft Windows and IBM OS/2. 
Stores files as a series of dots, or pixels. It has a 
maximum of 16.7 million colors (24 bits per pixel) 
and files have the extension .bmp.
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	 	TIFF (Tagged Image File Format): It stores 
compressed files with a flexible number of 
bits per pixel. It provides the highest quality 
but has large file sizes. This format supports  
16.7 million colors (24 bits per pixel) and files 
have the extension .tif.

	 2.	To open and setup a new document in Photoshop, 
perform the following steps:

	 (i)	 Click File → New. It will open the New dialog 
box.

	 (ii)	 Choose a desired option from Preset such as 
Default Photoshop Size, U.S Paper Photo, and 
Web, etc. Set the Size of Preset as your need.

	 (iii)	 Click OK. It will setup the new document.
		 Now, you can add graphics and text in the 

document as per your need.
		 To save an image document,
		 Click File → Save As
		 The Save As dialog box will open.
		 Type the filename, select the desired image 

format and click Save.
	 3.	Adobe Photoshop CS5 interface layout is listed 

and explained below:
		 Application bar is displayed at the top of the 

screen. In the Application bar are the Photoshop 
application icon, the main menu (Windows 
only), application controls, View controls, the 
workspace switcher, and a button to access CS 
Live. Below the Application bar is the Options 
bar, with the Tools panel on the left, panels, and 
one or more document windows that are opened 
separately.

		 The main menu across the bottom of the Application 
bar organizes commands in individual menus.

		 The Options bar displays options for the currently 
selected tool.

		 The document window displays the file you are 
working on.

		 The Tools panel contains tools for creating and 
editing images, artwork, page elements, and so 
on. Related tools are grouped together.

		 Panels help you monitor and modify your work. 
An example is the Layers panel. Certain panels 
are displayed by default, but you can add any 

panel by selecting it from the Window menu. 
Many panels have menus with panel-specific 
options. You can separate, group, stack, and 
dock panels into your preferred layout.

	 4.	The basic image editing techniques are useful 
when working with digital scans of images. 
We can apply these basic techniques in a wide 
variety of image editing situations.

		 Cropping
		 Cropping is the process of removing portions 

of an image to create focus or strengthen the 
composition. You can crop an image using the 
Crop Tool and the Crop command. You can also 
trim pixels using the Crop And Straighten and 
the Trim commands.

		 To crop an image, perform the following steps:
	 (i)	 Open the image file you want to crop and 

click on the CropTool from Tools panel.
	 (ii)	 Click and drag the mouse button to make a 

crop box.
	 (iii)	 Press the Enter key to crop the image.
		 The selected area of image will be cropped.
		 Resizing
		 There will be times when you need to make an 

object bigger or smaller as you copy it from one 
picture to another.

		 To resize an image, perform the following steps:
	 (i)	 Open the image file you want to resize.
	 (ii)	 Click Image from the Menu bar and then select 

Image Size…. It will open Image Size dialog 
box.

	 (iii)	 Set new image size using Pixel Dimensions or 
Document Size and click OK.

		 The image will resize as per your entered 
dimensions.

		 Correcting
		 Adjusting proper intensity, contrast range, 

and color balance is very easy using image 
processing programs. Suppose, we want the 
color adjustment.

		 To adjust the color balance, perform the following 
steps:

	 (i)	 Open the image file.
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	 (ii)	 Click Image from the Menu bar Adjustments 
→ Color Balance…. It will open Color Balance 
dialog box.

	 (iii)	 Set your desired color balance and click OK.
		 Sharpening/Softening
		 Generally, a scanned image is not as sharp as 

you might wish. Sometimes you may get very 
sharp image. So, you may require sharpening/
softening of the image. First of all open the 
document having the image to sharpen/soften.

		 For sharpening an image,
		 Click Filter from the Menu bar → Sharpen.
		 The options available are: Sharpen, Sharpen Edges, 

Sharpen More, Smart Sharpen and Unsharp Masks.
		 Select the desired option. The image will 

sharpen.
		 For softening an image,
		 Click Filter from the Menu bar → Blur.
		 The options available are: Average, Blur, Blur More, 

Box Blur, Gaussian Blur, Lens Blur, Motion Blur, 
Radial Blur, Shape Blur, Smart Blur and Surface 
Blur.

		 Select the desired option. The image will soften.

Suggested Activities

Refer to sub-units 5.1 to 5.3 of the Student Textbook 
for doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Image Processing and Multimedia Systems”.

Additional Questions

	 1.	Discuss the fundamental steps in digital image 
processing.

	 2.	List some image processing programs and discuss 
their capabilities.

	 3.	Discuss some drawing tools of Adobe 
Photoshop.

	 4.	 Identify applications of multimedia and explain 
how multimedia is used on the Web.
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Grade 11 
Minimum Learning Competencies (MLCs)

S. No. Units Minimum Learning Competencies (MLCs)
1. Information System Describe some applications of ICT•	

Explain the definition of each types of IS•	
Explain the application of each types of IS•	
Describe the  impact of ICT in everyday life•	

2. Enhancing the Use of 
Software

Solve problems by specific software •	
Illustrate their ideas•	
Organising their contents•	
Testing their hypotheses•	

3. Basic Troubleshooting Identify proper location for the computer•	
Protect computers from harm and damage•	
Explain possible problems that may occur with the power supply•	
Explain the use of stabilisers and UPS•	
Back up files stored in the computer•	
Use defragmenter and disk cleanup to improve hard disk •	
performances  
Apply safe methods•	
Define ESD (Electro Static Discharge)•	
Identify some ESD types•	
List some types of ESD protection devices•	
Explain  the concept of ergonomically correct computer and seating •	
Plug properly input and output devices with the system unit•	
Describe the general steps to troubleshoot problems•	
Troubleshoot minor problems related with some common input and •	
output devices
Install and uninstall applications software•	

4. Exploiting the Internet Use Boolean searching techniques•	
Report on improvements•	
Explain the functionability of wikis, blogs and podcasts•	
List the advantages of their use•	
Explain what is meant by “social networking”•	
Design a simple webpage•	
Implement the webpage publish webpage•	

5. Image Processing and 
Multimedia Systems

Define Image processing •	
List and explain different types of image file formats•	
Open and setup a new document.•	
Save an image document.•	
List and explain common interface layout of image processing •	
software
Edit an image in a desired way•	
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Grade 11 SYLLABUS

INTRODUCTION

In the preparatory schools students follow either the Social Science stream or the Natural Science stream; all 
students will continue to study IT.  
	 In the long term, students will follow a common course of IT, irrespective of which stream they are in. 
This course will cover Information Systems, Basic troubleshooting, Image processing and Multimedia Systems 
in some depth.  There will also be many opportunities to use software applications and tools that they have 
encountered during studies in earlier grades.
	 In future years, students may elect to follow a more-specialist course in Computer Science covering such 
areas as Computer Architecture, Systems Analysis and Design, Data Communications and Fundamentals of 
Programming.
	 In the short term, Grades 11 and 12 students will continue to follow the old Information Technology course 
until it is appropriate to introduce the new curriculum as described above.
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GLOSSARY

A

 Absolute Reference: Commonly used in 
spreadsheet applications, it is a formulated cell 
reference that will not adjust when used to calculate 
the sum of specific cells.
 Access: A database program which is a part of the 
Microsoft Office suite of programs.
 Address Book: In e-mail, list of regular contacts’ 
addresses held in the e-mail software.
 AI (Artificial Intelligence): It is the branch of 
computer science concerned with making computers 
behave like humans.
 Alignment: Positioning of text according to the 
margins and baseline.
 Analog: It is any fluctuating, evolving, or 
continually changing process that represents data by 
measurement of a continuous physical variable. 
 Animation: The display of a sequence of images 
in a computer program or on a Webpage to give the 
impression of movement.
 Application Software: A program that is designed 
to perform specific tasks.
 ASCII: American Standard Code for Information 
Interchange. It is pronounced (as-kee).
 Attachment:  An attachment can be a file of almost 
any kind—a document file, an image file, a sound file 
or a video clip—that we can add, i.e., attach, to an 
email.

b

 Backup: To copy files or data to a second source 
or media so as to safeguard it. 
 Bandwidth: A measurement of how much data 
(bits per second) can be sent through a connection.
 BCD: Binary Coded Decimal.
 Binary: A basic numbering system consisting of 1s 
and 0s. 

 BIT (Binary DigIT): It is the smallest unit of 
processing of computerized data in terms of 1s 
or 0s.
 Blog: (Slang term for a Weblog) A blog is a personal 
journal that can be accessed publicly and allow people 
to comment on the previously posted comments.
 Bluetooth: A wireless networking technology 
using radio waves that enables user to send data and 
voice signals between devices over short distances.
 BMP (Bitmap): It is a standard uncompressed 
format for Microsoft Windows and IBM OS/2.
 Boolean Searching: Boolean searching is built on 
a method of symbolic logic developed by George Boole, 
a 19th century English mathematician. Most search 
engines support Boolean searches.
 Booting: Starting a computer by loading the 
operating system into memory.
 Broadband: A general term used to describe a 
high-speed connection to the Internet.
 Browser: Software program that allows the user to 
find and read encoded information in a form suitable 
for display especially on World Wide Web.
 Byte: A combination of 8 bits to represent computer 
data transfer or data storage measurement. 

C

 Cell: Intersection of a row and column in a 
worksheet.
 CD-ROM (Compact Disc Read-Only Memory): A 
durable and low cost circular optical storage device 
widely used to store large amounts of information.
 Clipart or Clip Art: A collection of image files that 
can be embedded or inserted into Web pages, word-
processed documents, PowerPoint presentations, etc.
 Compiler: A type of system software that translates 
a source program usually written in a high level 
language into a machine language.
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	 Computer: An electronic device that accepts, 
processes, stores and outputs data under the control 
of a set of instructions.
	 Computer Laboratory: A special place where 
computers are kept to operate.
	 Computer Program: A set of instructions that the 
computer carries out to perform a given task.
	 Copy, Cut and Paste: Techniques of duplicating 
or removing data from one place and inserting it 
elsewhere.
	 Copyright: New technologies have raised all kinds 
of new issues relating to copyright—mainly because it 
has become so easy to copy materials from a variety of 
digital sources.
	 Cropping: The process of removing portions of an 
image to create focus or strengthen the composition.
	 CPU (Central Processing Unit): A processor on 
an IC chip (called a microprocessor) that serves as the 
‘brain’ of the computer. 
	 Cursor: A movable, blinking symbol that indicates 
the position on a computer screen where user action 
is needed.

D

	 Data: A collection of raw facts and figures or a 
raw input which when processed or arranged makes 
meaningful output.
	 Database: A structured collection of data that can 
be used for a variety of purposes.
	 Data Communications: The moving or sharing 
of encoded information between two or more data 
sources using an electronic medium.
	 DBMS (Database Management System): 
Application software which enables the storage, 
modification, retrieval, and querying of data in a 
database.
		 Debug: To test a program and remove all the bugs 
(errors).
	 Defragmenter Utility Program: It finds all the 
scattered files on the hard disk and reorganizes them 
as contiguous files.
	 Desktop: The primary display screen of a graphical 
user interface, on which various icons represent files, 
groups of files, programs, which can be moved, 
accessed, added to, deleted, etc. on a real desk.
	 Desktop Publishing (DTP): Application software 
for laying out text, graphics and pictures in order to 
produce a professional-looking publication.

	 Digital: A system that defines data in a discrete, 
non-fluctuating (i.e., non-analogue), numerical digits, 
specially 1s or 0s.
	 Digital Device: A device that works with discrete 
numbers or digits.
	 Disk Fragmentation: The scattering of portions of 
files about the disk in nonadjacent areas, thus greatly 
slowing access to the files.
	 Disk Cleanup Utility: It can search for and remove 
unnecessary files such as temporary files, or “temp 
files”.
	 Directory:  An organizing unit in a computer’s file 
system for storing and locating files. In a hierarchical 
file system, directories can contain subdirectories as 
well as files.
	 Distribution List: Also called a mailing list, is a 
collection of e-mail addresses that allows you to e-mail 
multiple people at one time.
	 Domain Name System: An addressing system 
in which abbreviations are used to indicate the type 
of organization or entity instead of whole name, for 
example, .edu for educational institution.
	 DSS (Decision Support System): A computer-
based information system that provides a flexible tool 
for analysis and helps managers focus on the future.
	 Downloading: It means transmitting data from 
a remote computer to a local computer, as from a 
website to your own PC.
	 DVD: Digital Versatile Disc or Digital Video Disc.
	 Dynaset: Set of records returned by a query.

E

	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 Electro Static Discharge (ESD): The release of 
static electricity when two objects come into contact.
	 E-Mail: Stands for Electronic Mail. This is a system 
of relaying messages across the Internet, from one 
Internet user to another.
	 Encryption: A system of coding that helps prevent 
access to private information on computer networks 
or on the Web.
	 EPROM: Erasable Programmable Read-Only 
Memory (“ee-prom”). It is a memory chip whose 
contents can be erased by a mechanism using ultraviolet 
light and reprogrammed for other purposes.
	 Ergonomics: The study of the interaction between 
people and machines.
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	 ESS (Executive Support System): An easy-to-use 
Decision Support System made especially for top 
managers; it specifically supports strategic decision 
making.

F

	 Flash Player and Flash Professional: Software 
produced by Adobe for the development and viewing 
of animated and interactive sequences on the Web.
	 Firmware: A microprogram stored in read-only 
memory (ROM), designed to implement a function 
that had previously been provided in software.
	 Folder: An alternative word for a directory and 
which has become more common since the introduction 
of Windows.
	 Forms: Used to provide an easy to use interface for 
user to enter, view and modify data in a table.
	 Format: The arrangement of data for computer 
input or output, such as the number and size of 
fields in a record or the spacing and punctuation of 
information in a report. It is also to prepare a disk for 
reading and writing.
	 Format Painter: Helps to copy the format that has 
been applied to text and apply it to another.
	 Freeware: This is a shortened version of Free 
Software. Programmers offer their work without 
wanting pay in return.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G

	 GIF (Graphics Interchange Format): It is 
pronounced “jif”, supports upto 256 colours  
(8 bits per pixel).
	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GIGO: It is an acronym that stands for Garbage In, 
Garbage Out.
	 Google: A popular search engine.
	 GUI (Graphical User Interface): A program 
interface that takes advantage of the computer’s 
graphics capabilities to make the program easier to 
use. Well-designed graphical user interfaces can free 
the user from learning complex command languages.

H

	 Hacker: A person who spends his/her time trying 
to gain access to information stored on other people’s 
computers all around the world.

	 Hardcopy or Hard Copy: Printed output from a 
computer, as opposed to output on screen.
	 Hardware: The physical equipment used in a 
computer system, such as the CPU, peripheral devices 
and memory.
	 Home Page: The initial page of a site on the World 
Wide Web.
	 HTML: Hypertext Markup Language. It is a 
collection of structuring and formatting tags used to 
create Web pages.
	 HTTP (Hyper Text Transport Protocol): The 
standard protocol for transferring hypertext documents 
on the World Wide Web. 
	 Hyperlinks: A word or graphic display on one 
web page that allows a computer to shift to another 
related web page.
	 Hypertext: A method of storing data through a 
computer program that allows a user to create and 
link fields of information at will and to retrieve the 
data non-sequentially.

I
	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 IC: Abbreviation for Integrated Circuit.
	 ICT: Information and Communication 
Technology.
	 IDE (Integrated Development Environment): 
A programming environment integrated into an 
application.
	 Image Processing: The set of computational 
techniques for analyzing, enhancing, compressing, 
and reconstructing images, generally with a digital 
computer.
	 Information: Meaningfully organized data.
	 Information System: A system that provides 
information to people in an organization.
	 Input: Anything that goes into a computer in order 
to be processed and/or stored. 
	 Input Device: A device that allow people to put 
data into the computer in a form that the computer 
can use. For example, keyboard.
	 Internet Explorer: A browser produced by the 
Microsoft Corporation and supplied together with the 
Windows operating system.
	 Integrated Circuit (IC): A circuit of transistors, 
resistors, and capacitors constructed on a single 
semiconductor wafer or chip, in which the components 
are interconnected to perform a given function.
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	 Interface: This is any type of point where two 
different things come together. Most often, the term is 
used to describe the programs between you and your 
computer like Windows, UNIX and others. What you 
see on the screen is the interface between you and 
what your computer is doing.
	 Interpreter:  It translates and executes source 
program, written in high level language, statement-
by-statement.
	 Internet: The Internet is a network of networks 
all of which use the same set of communications 
protocols. 
	 Intranet: A private network for communications 
and sharing of information that, like the Internet, is 
based on TCP/IP but is accessible only to authorized 
users within an organization. An organization’s 
intranet is usually protected from external access by a 
firewall.
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.
	 IT (Information Technology): The develop-
ment, implementation, and maintenance of computer 
hardware and software systems to organize and 
communicate information electronically.

J

	 JAVA: A high-level programming language 
developed by Sun Microsystems.
	 Joystick: A device that looks a bit like a gear 
lever in a car. This is connected to a computer and is 
used mainly for controlling the cursor in fast action 
games.
	 JPEG (Joint Picture Experts Group): It is 
pronounced “jay peg”. It supports 16.7 million colors 
(24 bits per pixel).

K

	 Keyboard: An input device which is used to 
enter information which the computer displays or 
processes.
	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L

	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.

	 Language Processor: Software that converts a 
high level language or assembly language code into 
machine understandable form.
	 Laptop Computer: A computer that is light and 
can easily be carried around.
	 Laser Printer: A type of printer that produces 
high-quality output at a reasonable speed.
	 LCD (Liquid Crystal Display): A method of 
displaying readings continuously using a liquid-
crystal film, sealed between glass plates that changes 
its optical properties when a voltage is applied.
	 Linker: A program specifically designed to combine 
or link together a large number of programs forming 
a single executable instruction set for these programs 
that can be loaded into the systems memory for quick 
execution.
	 Login: To attach to a computer using the user’s 
ID.
	 LOGO (Logic Oriented, Graphics Oriented): A 
high level programming language specifically designed 
for its ease of use and graphics capabilities. 

M

	 Mainframe: Second largest computer available 
after the supercomputer.
	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 Microcomputer: A category of computer that 
is generally used for personal computing, for small 
business computing, and as a workstation attached 
to large computers or to other small computers on a 
network.
	 Microprocessor: An integrated computer circuit 
that performs all the functions of a CPU.
	 Microsoft Office: A suite of programs produced by 
Microsoft Corporation, comprising a Word-processor 
(Word), a Spreadsheet (Excel), a Presentation Program 
(PowerPoint), an Email package (Outlook), a Database 
program (Access), and a Desktop Publishing package 
(Publisher).
	 MIS (Management Information System): A 
computer-based information system that uses data 
recorded by Transaction Processing System as 
input into programs that produce routine reports as 
output.
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	 MODEM: Stands for MOdulator and DEModulator. 
It is a device that changes data from digital (computer 
language) to analog (phone line language) and then 
back again.
	 Motherboard: The main circuit board of a 
microcomputer.
	 Monitor: The screen on which output from a 
computer is displayed.
	 Mouse: A pointing device that is used by moving it 
around on the desk and pressing (clicking) a button.
	 MPEG (Motion Picture Experts Group): A format 
to make, view, and transfer both digital audio and 
digital video files.
	 MS-Access: Database application software, 
provided by Microsoft.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.
	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
	 MS-Word: Word processing application software, 
provided by Microsoft.
	 Multimedia: The integration of two or more types 
of information (text, images, audio, video, animation, 
etc.) in a single application.

N

	 Nanosecond: A billionth of a second. Many 
computer operations, such as the speed of memory 
chips, are measured in nanoseconds. Nanosecond is 
often abbreviated as ns.
	 Navigation: It is the process of finding the way, 
i.e., navigating, around a series of menus within a 
computer program or finding the way around the 
World Wide Web by means of a browser.
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 
	 Network: A system containing any combination 
of computers and its peripherals, used to transmit or 
receive information.
	 Newsgroup: An online discussion community 
found on the USENET system. These groups cover 
thousands of different topics of information and are 
offered free of charge.
	 Node: In networks, a processing location. A node 
can be a computer or some other device, such as a 
printer.

	 Notebook Computer: A type of Laptop Computer, 
but lighter and thinner—and therefore easy to carry 
around.

O

	 OAS (Office Automation System): It combines 
various technologies to reduce the manual 
labour required in operating and efficient office 
environment.
	 Offline: Not connected to a computer or network 
of computers.
	 Online: Connected to a computer or network of 
computers, especially the World Wide Web.
	 Operating System: A system software program 
that works as a bridge between computer hardware 
and the user. Operating systems perform basic tasks, 
such as recognizing input from the keyboard, sending 
output to the display screen, keeping track of files 
and directories on the disk, and controlling peripheral 
devices such as disk drives and printers. 
	 Outlook: A popular e-mail program, part of the 
Microsoft Office suite of programs.
	 Output: Anything that comes out of a computer 
after being processed.
	 Output Device: A device that translates information 
processed by the computer into a form that humans 
can understand.

P

	 PDA (Personal Digital Assistant): A handheld 
device that combines computing, telephone/fax, and 
networking features and serves as an organizer for 
personal information.
	 PDF (Portable Document Format): A technology 
developed by Adobe and was designed to capture all 
of the elements of a printed document and place it in 
a single image file.
	 Pen Drive: A secondary storage device that can be 
used to easily transfer files between USB-compatible 
systems.
	 Peripheral: Any external device attached to a 
computer.
	 Pixel: The smallest element of an image that can be 
individually processed in a video display system.
	 Plotter: A computer output device that draws 
images on paper using a pen.
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	 Podcasts: Online broadcasts that can be downloaded 
to portable devices.
	 Portal: A Webpage, website or service that acts as 
link or entrance to other websites on the Internet.
	 Printout: Anything produced on a printer after 
being processed by a computer program.
	 Primary Key: A set of one or more values in a 
database that uniquely identifies a record in a table.
	 Primitives: The LOGO commands are known as 
‘Primitives’.
	 Procedure: The sequence of actions or instructions 
to be followed in solving a problem or accomplishing 
a task. It may be used at one or more points in a 
computer program.
	 Processor: A device that processes programmed 
instructions and performs tasks. The speed at which 
the CPU processes information internally is measured 
in MegaHertz (MHz) and GigaHertz (GHz). 1 GHz is 
equal to 1,000 MHz.
	 Programmable Read-Only Memory (PROM): 
A special memory chip that is blank when first 
purchased. It can be written to by the user by using a 
special hardware program. Once the data is written to 
it, it cannot be erased or changed.
	 Protocol: A set of rules governing the format of 
messages that are exchanged between computers.
	 Public Domain: Material that is copyright free, 
whose copyright has expired, or which cannot be 
copyrighted.

Q

	 Query: Used to retrieve information on a certain 
condition from a database.

R

	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.
	 Reports: Used to present data in a printed 
format.
	 Resolution: A measure of the number of pixels or 
small dots displayed on a computer display screen, 
printer or scanner.
	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 

data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.
	 Router: A device in a network that handles message 
transfers between computers. 

S

	 Scroll Bar: A widget found in graphical user 
interface and used to show and control which portion 
of a document is currently visible in a window. A 
window may have a horizontal or, vertical scroll bar, 
or both.
	 Scanner: A device used to convert hard copy, e.g., 
a printed page, photograph or photographic negative, 
into a form that can be stored on a computer.
	 Screen Saver:  A moving picture or pattern that 
appears on the screen when you have not used the 
mouse or keyboard for a specified period of time.
	 Scroll: To move up and down or from side to side 
through a document or a Window to view or access all 
of its contents.
	 Search Engines: A computer program that searches 
documents, especially on the World Wide Web, for 
a specified word or words and provides a list of 
documents in which they are found.
	 Serial Port: A port or interface that can be 
used for serial communication, in which only  
1 bit is transmitted at a time. Most serial ports on 
personal computers conform to the RS-232C or RS-422 
standards.
	 Server: This is a mainframe computer that serves 
the other computers attached to it.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 SMS (Short Message Service): A popular 
wireless service that is used for sending and 
receiving short messages up to a maximum of  
160 characters. The service is used for text messaging 
between cell phones that are on a GSM (Global System 
for Mobile) network.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
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	 Social Networking: The grouping of individuals 
or organizations into specific groups.
	 Source Code: Program code written in a high level 
language.
	 Source data: Data for which the chart is 
prepared.
	 Spam: The disruptive unwanted messages, 
especially commercial messages posted on a computer 
network or sent as e-mail.
	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
	 Supercomputer: High-capacity computer with 
thousands of processors that is the fastest calculating 
device ever invented.
	 Switch: In networks, a device that filters and 
forwards packets between LAN segments.
	 Syntax: Grammatical rules and structural patterns 
governing the ordered use of appropriate words and 
symbols for issuing commands, writing code, of a 
programming language.
	 System: Collection of related components that 
interact to perform a task in order to accomplish a 
goal.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T

	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.
	 TCP/IP: Acronym for Transmission Control 
Protocol/Internet Protocol, the suite of communications 
protocols used to connect hosts on the Internet.
	 Technology: It is the usage and knowledge of 
tools, crafts, techniques, or systems, or methods of 
organizations.
	 Terabyte (TB): 2 to the 40th power (1,099,511,627,776) 
bytes.
	 TIFF (Tagged Image File Format): It stores 
compressed files with a flexible number of bits per 
pixel.
	 TPS (Transaction Processing System): A computer-
based information system that tracks the transactions 
needed to conduct business.
	 Toolbar: A row or rows of buttons on a display 
screen that are clicked on to select various functions 
in a software application or web browser.

	 Topology: In networking, this refers to the physical 
or logical arrangement of a network.
	 Touch-sensitive Screen: A display screen which 
enables the computer to react to the touch of a finger.
	 Transistor: A semiconductor device that amplifies, 
oscillates, or switches the flow of current between two 
terminals by varying the current or voltage.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.
	 Turtle: A triangular shape pointer used in LOGO 
that helps in drawing figures.
	 Twitter: A microblogging facility that 
allows users to post very short texts (maximum  
140 characters) containing snippets of information about 
what they are doing at a given moment, news items, 
links to websites or comments on events.

U

	 UNICODE: Binary coding scheme that uses 2 
bytes (16 bits) for each character. It allows almost all 
the written languages of the world to be represented 
using a single character set.
	 Uploading: It means transmitting data from a local 
computer to a remote computer, as from your PC to a 
website you are constructing.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 URL (Uniform Resource Locator): A protocol for 
specifying addresses on the Internet. It is an address 
that identifies a particular file on the Internet, usually 
consisting of the protocol as http, followed by the 
domain name.
	 User: Someone attached to a server or host.
	 User-friendly: Mainly used to describe software. 
Software that is easy to use and offers guidance if the 
user does silly things is described as user-friendly.
	 Utility Program: A program developed to run 
within an Operating System to perform a specific 
service.

V

	 Videoconferencing or Video Conferencing: A 
computer-based communications system that allows 
a group of computer users at different locations to 
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conduct a “virtual conference” in which the participants 
can see and hear one another as if they were in the 
same room participating in a real conference.
	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W

	 W3C (World Wide Web Consortium): An 
international non-profit organization which acts as a 
resource centre for the World Wide Web, and is active 
in setting technical standards.
	 WAN (Wide Area Network): A network in 
which computers are connected to each other over 
a long distance, using telephone lines and satellite 
communications.
	 WAV: Stands for WAVeform sound format. 
Microsoft’s format for encoding sound files.
	 Webcam: A camera connected to a computer and 
linking it to the Internet.
	 Web page or Webpage: A single, usually hypertext 
document on the World Wide Web that can incorporate 
text, graphics, sounds, etc.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Web site: A connected group of pages on the 
World Wide Web regarded as a single entity, usually 
maintained by one person or organization and 
developed to a single topic or several closely related 
topics.
	 Wizard: A utility that provides guided sequence to 
perform complex task easily and quickly.

	 Wifi: Wireless Fidelity, also known as wireless 
networking, a way of transmitting information without 
cables that is reasonably fast and is often used for 
laptop computers within a business or  school campus 
instead of a Local Area Network (LAN) that uses cable 
connections.
	 Wikis: Webpages that can be viewed and modified 
by anyone with a Web browser and Internet access.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 Workstation: The computer attached to the 
Internet.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X

	 XML (eXtensible Markup Language): It is a markup 
language, not limited to Web documents.

Y

	 YouTube: A website to which we can upload our 
own video clips and view video clips uploaded by 
others: http://www.youtube.com.

Z

	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.
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